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1 Introduction
1.1 Short description
Software for efector octavis diagnostic electronic VSExxx

1.2 Use
1.	 On-line condition monitoring with alarm outputs
2.	 Trend recording (internal history memory)
3.	 In-depth diagnosis (FFT mode)
4.	 Gateway for diagnostic values (in connection with octavis OPC server, article 

numbers VOS001...VOS004)

1.2.1 On-line condition monitoring
The diagnostic electronics VSExxx valuates and monitors max. 24 diagnosis 
objects (e.g. rolling element bearings, unbalance, gear-mesh, signal input-monitor 
etc) using the vibration signals of up to 4 connected vibration sensors (Type 
VSAxxx and IEPE) and the 2 DC inputs (e.g. speed or load). Damage progress 
can be indicated using binary switching outputs (e.g. early warning and alarm). 
Alternatively one output can be selected as analogue and the trend can be 
signalled continuously.
Integration into the production data acquisition system is possible using an OPC 
interface. An additional software is available (octavis OPC Server, article numbers 
VOS001...VOS004).

1.2.2 Trend recording (internal history memory)
All diagnosis object trends (history) can be stored in the diagnostic electronic 
(VSE). The integrated battery-backed real-time clock enables time tracking of 
events.

1.2.3 In-depth diagnosis (FFT mode)
If required a detailed analysis of the measurement data is possible using the FFT 
mode. Measurements can only be detected and recorded from one sensor at a 
time. The recorded data can be recalled as measurement data.

1.2.4 Gateway
All diagnosis objects and switching conditions can be integrated into a higher 
level data acquisition system using the OPC interface. This is realised using an 
additional software (octavis OPC server article numbers VOS001...VOS004). 
Furthermore it is also possible to read and write individual parameters using the 
OPC interface.
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2 Important notes
2.1 Factors which influence vibration monitoring
We wish to point out that deviations in and influences to the diagnosis values can 
generally occur during vibration monitoring. Therefore, for reliable monitoring it is 
important to pay attention to the following factors:

2.1.1 Selecting the mounting location
●● The measuring axis is vertical to the machine surface
●● Mount in massive housings only (not on metal cover plates)
●● Mount as close as possible to the bearing position to be monitored.

2.1.2 Quality of the measurement signal
●● Tighten the vibration sensor (type VSAxxx) with the given tightening torque
●● The conus washer (accessory article number E30115) improves the positive 

locking of the sensor (VSA001). This is recommended for bearing diagnosis.
●● Interference originating from the process can influence the diagnosis. We 

therefore recommend in the case of strongly deviating diagnosis values to limit 
the monitoring range or to reduce the bandwidth of the diagnosis objects. If the 
diagnosis values are subject to strong influences (e.g. metal cutting operations) 
we recommend recording a reference run.

2.1.3 Checking the teach values
The teach values are the reference values used to evaluate the diagnosis values. 
A teach value which is too high due to pre-damage or signals originating from 
the process can impede the correct display of the "earling warning" and "alarm" 
conditions. To check the teach values we recommend after a few days reading 
out the data recorded by the internal history memory and to make any necessary 
corrections to the alarm limits and the signal damping.

2.1.4 Evaluating the alarm limits
The given alarm limits for the diagnosis object "rolling element bearing" and 
"unbalance" are based on experience and relate to an undamaged condition.
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3 Function and features
1.	 The efector octavis diagnostic electronic (VSE) continually monitors the 

vibration acceleration detected by the vibrations sensors connected thereto, of 
non-rotating machine surfaces (up to 100,000 values/second). It calculates the 
acceleration and speed amplitudes of the set damage frequencies (e.g. inner 
race, outer race and rolling element) of up to 24 different diagnosis objects 
(incl. signal input-monitor). A total of 128 individual damage frequencies are 
possible (max. firmware 0.7.255 84 damage frequences). The rolling element 
bearings or diagnosis objects to be monitored are defined using a PC-
software and then transferred as a parameter set via Ethernet to the diagnostic 
electronic (VSE). The evaluation and condition monitoring of the rolling element 
bearing is then relative to the Teach value (reference value).

2.	 efector octavis can also calculate the maximum acceleration (0-peak in [mg]), 
weighted acceleration (RMS in [mg]) and/or average velocity (RMS in [mm/s]). 
The evaluation and monitoring is then in absolute limit values without a 
reference value.

3.	 Both process values (input 1/input 2) can be monitored separately from the 
diagnosis objects. They can also be recorded in the history memory.

4.	 Indication of early warning and main alarm: The diagnosis object or the signal 
input monitor with the highest degree of damage is indicated via the switching 
output. The highest diagnosis object value or damage level can also be 
indicated using a 0/4...20 mA current loop.

5.	 The damage condition of the diagnosis objects per sensor input is indicated on 
the diagnostic electronic‘s (VSE) integrated coloured LED display.

6.	 The diagnostic electronic (VSE) can be used with constant and variable 
speeds. To ensure correct diagnosis when using variable speeds the current 
speed has to be supplied via a current loop, pulse signal or Ethernet.

7.	 For use with variable speeds please ensure that the operational speed related 
to the set values remains constant for intermittent periods.

8.	 The recommended range for rolling element bearings in the standard mode 
(wizard) are operating shaft speeds between 120 rpm and 96,000 rpm. The 
maximum operating range is between 1 rpm and 100,000 rpm shaft speed.

9.	 The sensor is mounted via a screw fixture close to the rolling element bearing 
radial to the rotational axis (see sensor installation instructions).
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The diagnostic electronic (VSE) uses own  limit values for the set spectral 
diagnosis objects for early warning (yellow) and main alarm (red). The alarm limit 
values of the diagnosis objects are always related to the set Teach value and 
therefore describe a signal fan-out.
The diagnostic electronic (VSE) uses broad band limit values for the monitoring of 
the vibration level within the time domain. Contrary to the diagnosis objects these 
are absolute acceleration (unit [mg]) or velocity (unit [mm/s]) values. 
The diagnostic electronic (VSE) also allows monitoring in accordance to 
ISO 10816 as RMS vibration velocity in the range up to 1 000 Hz.
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4 User interface
After program start-up the first screen is divided into three segments:
1.	 Main menu (top): Program settings and standard window functions.
2.	 Overview (left): Hardware Overview (top left) indicating the diagnostic 

electronics (VSE) which are active and/or inactive addresses; File Overview 
(bottom left) indicating which octavis files are open and have beenused. The 
files can be parameter files, measurement files and history files.

3.	 First empty parameter set (center): efector octavis parameter set including the 
wizard function.

The main window contains the main menu and different tool bars.
In the overview window several diagnostic electronics (VSE) can be visualized in 
the diagnostic electronic-Overview tree, as well as files in the data/files-Overview 
tree. Please use the main menu, the toolbars or the appropriate context menu in 
the overview window. The functions listed in the main menu and the toolbars refer 
to the entry which is highlighted in the Overview tree (diagnostic electronic (VSE), 
parameter-file...). The pertinent entry also appears in the status bar below the 
relevant Overview tree.
When the program is restarted the connections and files last used, reappear in the 
Overview tree, provided they are still available.
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You can access the various data and functions (parameter 
set, monitoring, history and settings) in a new window by 
double clicking the appropriate entry of the diagnostic elec-
tronic (VSE) listed in the Overview tree.
Connections to the diagnostic electronics can be grouped 
together. Data and files can be grouped in the container 
(→ image). The package is a particular type of the con-
tainter.
If when starting the software it is not possible to display the 
program on the whole screen you can enter the available 
screen space for the parameter software VES003 using the 
start parameters "FRAME_left_top_right_bottom".
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5 Settings
5.1 Country settings
The language is selected under [File] > [Language].

5.2 Program settings
Main menu [Extras] > ]Preferences...]
The preferred units for length ([mm] or [inch]) and frequencies ([Hz] or [CPM]) can 
be set here.
If an edit mode is required, it is possible to show the signal weighting for speed, 
the 2nd working range of the diagnosis objects as well as the reference value of the 
signal input monitor.
The search radius for the peak search function is to be given in mesh points. One 
mesh point corresponds to the resolution set in the monitoring window. If, e.g. the 
setting was 1.526 Hz and 399.6 Hz is clicked the search function, for a frequency 
window of 10 mesh points, sets the line on the highest peak between 383.75 Hz 
(= 399.6 Hz – 10x 1.526 Hz) and 414.86 Hz (= 399.6 Hz + 10x 1.526 Hz).
The number of harmonics and sidebands to be shown can be set here.
Here it is possible to set whether or not the last connected units are to be 
reconnected automatically or if the listed units remain unconnected and each unit 
has to be connected manually.
Contrary to the standard setting it is possible in the VSE overview to include 
connections with identical IP addresses provided the port numbers are different. 
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6 Diagnostic electronic VSE
Using the toolbar  or context menu in the main menu you can create groups 
or new connections. Using the connection wizard it is possible to select a new 
connection as either an active or passive one. 
A passive connection contains all the information relevant to the connection. Using 
a double click it can be activated quickly by connecting either to the "Connection" 
function in the drop-down menu or to the symbol [Connection] . Equally 
quickly an active connection can be deactivated using a double click leading to the 
"Disonnect" function in the drop-down menu or to the symbol [Disconnect] .
The parameter set, monitoring, history and settings are 
shown as minor nodes. Use a double click to open them as 
a new window (→ image).
If an IP address is included in the startparameters as 
"aaa.bbb.ccc.ddd"or "aaa.bbb.ccc.ddd/eeee" (eeee= Port 
number), then at start up a connection is made to the given 
diagnostic electronic.

The functions listed in the main menu, tool-bars  
and context menu (Connect, Register, Reboot, Disconnect, 
Delete, Teach-In) apply to the highlighted diagnostic elec-
tronic or group only, which is also shown in the status bar 
below the Overview tree (→ image).

Important: Each diagnostic electronic (VSE) can be accessed by 3 different users 
at the same time, which means that several users can make changes to the VSE-
settings/parameters at the same time!

6.1 VSE > Groups
It is possible to collect freely definable "Groups" of connections to diagnostic 
electronics in the "VSE" overview tree.
The group reference remains after the program has been closed.
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6.2 VSE > Connection wizard

6.2.1 DHCP
The default setting for a connection uses a static IP address. 
From firmware version 0.6.8 onwards it is possible to assign dynamic IP addresses 
to the diagnostic electronic (VSE) (DHCP). The connection is then created using 
the host name.

6.2.2 IP Address
To connect the diagnostic electronic (VSE) you require the unit‘s IP address and 
the Port.
Factory setting: 
IP address = 192.168.0.1 
Port = 3321
Up to 3 different users can access the diagnostic electronic (VSE) at the same 
time.

6.2.3 Host name
If the network is configured with DHCP it is possible to establish a connection to 
the diagnostic electronic (VSE) using the host name.
The host name must be previously defined in the network settings.
Factory setting: Connection establishment using a static IP address. 
IP address = 192.168.0.1 
Port = 3321
Up to 3 different users can access the diagnostic electronic (VSE) at the same 
time.

6.2.4 Description
The name given to the connection which is shown in the VSE Overview tree.

6.2.5 Connection
It is possible to set up the parameters for the connection to the diagnostic 
electronic (VSE) without having to activate the network connection straight away.
The connection prepared in the overview can quickly be established via the menu 
or the symbol [Connection].
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6.3 VSE > Connect
Main menu [VSE] > [Connect...] or 
symbol  or  
Overview-context menu [Connect...].
A network connection is created using the previously defined data of the passive 
connection.

6.4 VSE > Login
Registration is required when accessing a password protected level if the user and 
access rights for the diagnostic electronic (VSE) have been limited for the different 
registration levels.
If the required level has been selected and the valid password has been entered, 
it is then possible to save the registration details in encoded form. The stored 
registration details are used for each connection. Otherwise the connection is 
established using the lowest access level and higher levels have to be accessed 
manually.

6.5 VSE > Reboot
The diagnostic electronic (VSE) can be rebooted using the software. Although the 
existing connection is lost. Changes made to network settings (IP Address, host 
name, subnet masks etc) remain valid. The existing connection is interrupted. If 
changes have been made to the network settings then a new connection has to be 
established.

6.6 VSE > Disconnect
Main menu [VSE] > [Disconnect] or 
symbol  or 
Overview-context menu [Disconnect].
The network connection is interrupted. The passive connection remains in the 
Overview tree containing the data relevant to the connection.

6.7 VSE > Delete
Main menu [VSE] > [Delete...] or 
symbol  or 
Overview-context menu [Delete...].
The network connection is interrupted and the diagnostic electronic (VSE) is 
removed from the Overview tree.
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6.8 VSE > Teach-In
Mainmenu [VSE] > [Teach-In] or 
symbol  or 
Overview-context menu [Teach-In].
The Teach function measures the reference values of the set diagnosis object and 
stores them in the diagnostic electronic (VSE). Diagnosis information relates to the 
Teach value. It is therefore necessary to ensure that the Teach measurement is not 
interrupted and conducted under typical operating conditions.
Reference and alarm values are preset for the diagnosis objects type "Rolling 
element bearing" and "Unbalance". These can be adjusted manually if so required 
by the maintenance process.
Diagnosis objects without a set Auto-Teach function cannot be activated in the list. 
The Teach measurement for each diagnosis object can be started separately or 
bundled for several diagnosis objects.
When the Teach process is completed the corresponding diagnosis object is 
marked with a green dot. An on-going Teach process is marked with blinking red 
dots (→ image).
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Notes for the use of Teach values:
1.	 The evaluation of the diagnosis object condition (e.g. bearing condition, 

unbalance etc.) is based on a relative signal increase related to the Teach 
value.

2.	 The Teach value or reference value can either be determined by measurement 
(Teach function) or manually entering the value. Typical reference and alarm 
values are preset for diagnosis objects type "Unbalance" and "Rolling element 
bearing".

3.	 If monitoring takes place on machines constructed in the same way and 
on identical measuring positions, then the Teach value (reference value) is 
identical. We therefore recommend saving the Teach value in the parameter set 
so that the same switching thresholds can be achieved on the same machines.

4.	 If the Teach value is measured please ensure that the machine is operating 
under typical conditions and in undamaged condition. 

5.	 If Teach values (reference values) are influenced by process factors (e.g. load 
or speed) we recommend defining a corresponding monitoring window with 
constant operating conditions. These can be triggered under the working range 
or variant switching. If a Teach measurement is carried out please ensure that 
the corresponding constraints (e.g. speed, load window or trigger input) are 
applied.

6.9 VSE > Parameters
The parameters are updated if another user changes the parameter values of the 
diagnostic electronic (VSE) using the function "Write parameters" or by teaching 
the sensor (→ VSE).
As soon as the VSE-parameters have been changed in the wizard or in another 
property window and have been confirmed with [OK], then a copy of the parameter 
set is stored under the Overview tree "data/files". The VSE parameter window 
always indicated the actual unit parameters.
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6.10 VSE > Monitoring
When selecting the type of display in the window [Monitor] the measurement 
values can be visualised in different evaluation levels:

 
from left to right:

●● In/Outputs
●● Counters
●● Copy diagram to clipboard
●● Spectrum monitoring
●● Subobjects
●● Objects
●● Damage level

The values for the "In/Outputs" and “counters” are shown in an extra window. The 
four alternative evaluation levels "spectrum monitoring", "Subobjects", "Objects" 
and "Damage level" can then be displayed at the same time.
Use  [copy diagram to clipboard] to paste an inverse coloured image of the 
diagram to the clipboard
With  the indicated data can be stored continuously (Data-Streaming) and 
then visualised again. This enables efector octavis to be used as a measuring 
instrument. In the modes "Subobjects", "Objects" and "Diagnosis value" the 
measuring values of the diagnosis objects / signal input monitors of all sensors 
are recorded. The values of the "In/Outputs" are saved in all recordings and be 
recalled.
The recording is stored as a symbol in the Overview tree "Data/Files" and can be 
retrieved for visualisation, stored as a file and/or reloaded.
With  the diagram showing the ingoing values can be stopped for analysis 
purposes. This does not affect a running recording.
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6.10.1 Monitoring > In/Outputs
The measured values forwarded to the VSE in- and outputs are displayed.

Example VSE001 / VSE002 Example VSE100

6.10.2 Counters
Shows the current status of the set counters.
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6.10.3 Monitoring > Spectrum monitoring
Indicates the linear spectrum (FFT) of each sensor for in-depth diagnosis.
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Following settings can be changed:
●● Resolution: 0.19...24.4 Hz (11.44...1 464.84 CMP)
●● Frequency band: depends on the resolution
●● Filter: Select the parameterised filter
●● Measuring unit: [mg], [mm/s] and [mm]
●● Method of analysis: 

–– FFT (Linear spectrum of the raw signal)
–– H-FFT (Linear spectrum of the demodulated curve signals) with selectable 

envelope filter
The windowing is conducted via a Hanning window.
It is possible to zoom into the diagram by drawing a rectangle (keep left mouse 
button pressed and drag from top left corner to bottom right corner). To zoom out 
again repeat in the opposite direction.
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Use a right mouse click to select different functions in the context menu.
●● Highlight the damage frequencies set in the VSE as coloured vertical lines 

([Subobjects]). Use the shown control boxes to limit the selected diagnosis 
objects. If the drag and drop function has been used to draw a parameter set 
from the "Overview" window to the monitor window then damage frequencies of 
the drawn parameter set will be shown.

●● Shows the frequency range of the shown subobjects if the cursor is positioned 
on the line.

●● Shows the harmonics. The first harmonic can be determined by mouse click  
. The search function can be used to determine the position of the highest 

peak situated closest to the mouse click. The frequency range of this search 
function and the number of harmonics can be altered in the programme 
settings.

●● Shows the sidebands. The basic band of the sidebands and the first sideband 
can be determined by mouse click . The search function can be used to 
determine the position of the highest peak situated closest to the mouse click. 
The frequency range of this search function and the number of sidebands can 
be altered in the programme settings.

●● Manual highlighting as coloured vertical lines ([Label]). Use the mouse to 
determine the position of the label . The following pop-up window is used 
to determine the colour, description of the lines and the dependency of the 
position on a speed value.

●● Shows the cursor field.
●● Simulation of the sliding averages (1/1, 1/2, 1/4, 1/8, 1/16, 1/32, 1/64, 1/128, 

1/256).
Use the arrow keys (arrow right, arrow left) to move the cursor. For large steps use 
Shift + arrow left or Shift + arrow right. Pos1 or Strg + arrow left moves the input 
focus to the left cursor. End + arrow right moves the input focus to the right cursor.
Important: In the FFT-Mode the monitoring of diagnosis objects is deactivated 
so that the switching outputs do not switch. If the IP-connection between the 
diagnostic electronic (VSE) and the PC is interrupted in the spectral display the 
diagnostic electronic (VSE) automatically switches back again to the monitoring 
condition within a few minutes.
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6.10.4 Monitoring > Subobjects
Indicates the damage frequencies (e.g. for rolling element bearing diagnosis: 
inner race, outerrace, ball pass frequencies). In the subobject mode the damage 
relevant frequency groups with amplitudes and the frequencies found per 
diagnosis object are displayed. The spectral evaluation can be made from the raw 
signal or from the demodulated envelope curve time signal. The settings in the 
diagnostic electronic (VSE) are valid. If the method of analysis is changed then the 
parameters have to be changed as well.
The diagram corresponds to a frequency factor analysis.

6.10.5 Monitoring > Objects
The unweighted and averaged characteristic values are shown for each set 
diagnosis object pertaining to the selected sensor. They are grouped according 
to the selected unit (evaluation of the diagnosis objects). The relevant reference 
values from the Teach-In are shown additionally as blue bars provided that a 
Teach-In has already been conducted.
The evaluation can be selected from the raw signal or from the demodulated time 
signal. The settings of the diagnostic electronic (VSE) are valid. If the method of 
analysis is changed then the parameters have to be changed as well.

6.10.6 Monitoring > Damage level
The weighted and averaged parameters / timedomain values are indicated for 
each set diagnosis object/vibration monitor pertaining to the selected sensor. The 
Teach values for the diagnosis objects are used as reference values.
The evaluation can be selected from the raw signal or from the demodulated 
time signal. The set parameters in the diagnostic electronic (VSE) are valid. If the 
method of analysis is changed then the parameters have to be changed as well. 
As soon as new values have been calculated a new value is then shown.
If no valid value could be determined during the diagnostic interval then the cause 
is indicated in form of the following abbreviations:

No teach no valid Teach value

inv T N no valid reference Teach (speed)

inv T 2 no valid reference Teach (2nd working range)

N dev speed deviations are too high

N out speed is outside the working range

Wght N 0 deactivated by signal weighting speed

WR 2 out value is outside the 2nd working range, deactivated by signal weighting 2nd working 
range

Err C calculation error

Err I internal error

inactive Deactivated by variant
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The limit values indicated correspond to the limit values set in the diagnostic 
electronic (VSE) and correlate with the LED-display on the diagnostic electronic 
(VSE).
The weighted and average input values are indicated for each of the process 
monitors set for the selected input.

6.11 VSE > History

6.11.1 Time-based history
The efector octavis diagnostic electronic (VSE) has an internal history memory to 
record the diagnosis object / signal input monitor values.
The integrated real-time clock should be aligned with the computer system 
time using the function [Settings] > [Others] > [Reset history]. If the clocks have 
changed during the reporting period, the data stored before the change will also be 
shown in the currently valid time.
The memory is structured as a ring memory so that the current values are 
accessable.
The size of the memory amounts to 600 000 values (max. firmware 0.7.255 approx 
30.000 values) including time stamp and speed information. These are then 
segmented according to the active diagnosis objects / signal input monitor. The 
history memory settings (diagnosis objects / signal input monitor which are to be 
saved, storage intervals) are freely selectable.
The history data which has been read out is stored in the Overview tree "data/files" 
and can be stored in file format.
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6.12 VSE > Settings
As soon as the "Transfer" function is completed the changed settings are valid 
immediately in the diagnostic electronic (VSE).

6.12.1 Settings > Info
Data pertaining to the individual diagnostic electronic (VSE): Type, Serial number, 
Hardware-Version, Firmware-Version, MAC Address.

6.12.2 Settings > Password Protection
From firmware 0.6.8 onwards it is possible to limit the access rights for different 
functions at different registration levels using (user) password protection. The user 
has to be registered in the required level in order to use the various functions.

Both lists in the top two boxes show the valid and withdrawn access rights for the 
active registration level 
The selection box in the header of the bottom group box shows the valid and 
withdrawn access rights for the available registration levels.
It is only possible to show and edit the registration level rights which are lower than 
the currently accessed level.
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The rights can be hierachically limited from top to bottom. Whereby:
●● The top level (level 4) always maintains all rights and serves as administrator
●● "Level OPC” uses the octavis OPC server software (article numbers VOS001...

VOS004) and can only be set at level 4
●● The following levels can only be assigned with access rights which the level 

above already has (e.g. Level 2 cannot be assigned with access rights which 
differ to level 3).

●● It is only possible to change the access rights for a lower registration level than 
is currently in use (e.g. registration in level 2 → to change access rights in 
levels 1 and 0.

●● It is possible to overwrite the passwords in the current and lower registration 
levels.

●● Country specific letters such as "ä" or "ê" are NOT possible.
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6.12.3 Settings > Sensors
It is possible to designate a description of up to 31 digits to each sensor.
Scaling means the highest amplitude pertaining to the connected sensor. Please 
refer to the data sheet. This also applies to the unit of the measured values. Each 
accelerometer ([mg], [m/s²], [g]) converts internally with [m/s²] in order to ensure 
the vibration velocity is correctly calculated in [m/s].
Important: The diagnostic electronic (VSE) is optimized for use with vibration 
sensors from ifm electronic, which are based on a micro-mechanical measuring 
principle and have a dynamic current loop of 0...10 mA (type VSAxxx).
An analogue filter can be used to adjust the time domain monitor to the applica-
tion.RMS measurements according to ISO 10816 require above 2Hz for speeds > 
120 and < 600 rpm and above 10Hz for speeds over 600 rpm.
For VSE002/VSE100 units it is also possible to connect piezo electronic sensors 
(type IEPE) (max. firmware version 0.7.255 to sensor input 1 only).
Max. firmware-version 0.7.255 it is possible to amplify the IEPE sensor signal by a 
factor of 10 to increase the sensitivity of the sensor and to distinguish the signals 
from the noise. In this case the measuring range is reduced e.g. from 500 g pk to a 
tenth (= 50 g pk).
A sensor self-test cannot be carried out on a IEPE sensor. An integrated selftest is 
only possible for micromechanical sensors type VSA from ifm electronic.

6.12.4 Settings > Sensor self-test
Please refer to the relevant datasheet to check if the sensor is suitable.
The self-test is carried out as soon as the sensor is powered-up. It can also be set 
to be carried out automatically in predefined cycles (minimum cycle time 1 min).
Following settings are possible in case of a negative self-test:

●● Output OUT1 (provided the analogue output is set in [mA] to emit a 22 mA 
analogue signal (minimum firmware version required 0.5.19) and/or

●● Output OUT2 to be constantly switched or pulsed at 1 Hz
●● I/O1...8 to be constantly switched or pulsed at 1 Hz.
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6.12.5 Settings > Network
Please enter the IP address and Port number valid for your network for the 
diagnostic electronic (VSE) as well as the subnet mask for your network. From 
firmware version 0.6.8 onwards it is possible to assign the diagnostic electronic 
(VSE) with a dynamic IP address. The connection is established using the host 
name which is to be entered here. If other subnets should be connected to the 
diagnostic electronic it is necessary to enter the IP address of the gateway. It is 
necessary in any case to input the valid subnet masks.
Please note: For technical reasons changes to network settings are only valid 
after restarting the diagnostic electronic (VSE)!
For comprehensive network operation, gateway computers and firewalls have 
to be appropriately configured. Some virus detection programs also have to be 
cleared with the set Port number and/or IP address.

6.12.6 Settings > Miscellaneous
Test switching output
The switching outputs can be manually switched for test purposes. The same 
applies to the output current loop on OUT1 as variable with values between 0 mA 
and 20 mA.
Reset the diagnostic electronic (VSE) parameters
All data (not settings) will be deleted including the Teach data. The VSE settings 
for IP address, sensor name and scaling remain unchanged.
Reset history
When the history has been reset the internal history memory is cleared and the 
clock in the diagnostic electronic is adjusted to the computer system time.
Reset settings
The VSE settings (sensor settings and selt-test, variants) are reset to factory 
settings. The network settings remain unchanged.
Level 4
At level 4 it is possible to reset all passwords and access rights (from firmware 
version 0.6.8 onwards).
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Set counter (valid from firmware version 0.6.8 onwards) 
It is possible to select the values for active counters:

Using [Accept] the corresponding counter level is transferred to the VSE.

6.12.7 Settings > Variants
The variants selection can be used to trigger monitoring of diagnosis objects / 
signal input monitors. Triggers can be set using the software (Parameter setting 
software VES003 or using the octavis OPC Server article numbers VOS001...
VOS004) as well as the hardware als electrical signals (level-trigger) (only possible 
using VSE100).
The active variant is displayed. If no variant is set the variant 0 is valid.
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7 Data / Files
You can use menu, the symbols  or the context menu to create settings, 
packages, containers or empty parameter sets, and open parameter files, 
measuring data, packages, history files or, setting files.
Using a double click all open files and parameter sets can be reopened in a new 
window. When a parameter window is closed data which has not be saved will not 
be lost. When deleting the parameter node or measuring data node which contains 
data which has been changed but not saved the save dialog automatically appears 
on the screen.
The functions listed in the main menu, tool-bars  and 
context menu ([Save], [Save as...], [Remove]) apply to the 
highlighted parameter node, history or measuring data node 
only, which are also shown in the status bar below the Over-
view tree (→ image).

History files from the same diagnostic electronic (VSE) can be merged into one 
file:
Main menu [File] > [Merge] or  
symbol  or 
in the context menu [Merge]".
This makes it possible to continually store the history data of one unit in the same 
file over a longer period than is possible for the unit‘s history memory. However, 
this is dependent on the capacity of the computer used. 

7.1 Data / Files > Containers
In the "Data/Files"-Overview tree you can group parameter sets and measurement 
data which are thematically connected in "Containers".

7.2 Data / Files > Packages
A package contains exactly one parameter set and the corresponding setting.
Use drag and drop to extract a package from a connected VSE. In the same way it 
is also possible to transfer a package to a VSE.
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7.3 Data / Files > Parameters
Parameters are required to configure the diagnostic electronic (VSE) for machine 
diagnosis.
To create a new parameter set please let the wizard guide you through all the 
relevant parameter settings.
If you wish to edit a parameter set you can make changes to individual values in 
the relevant window [preferences] (Application, counter, diagnosis object, signal 
input monitor, history, variants and project). The window [preferences] contains the 
parameters of the diagnosis object or signal input monitor which is highlighted in 
the fault tree.

7.3.1 Parameters > Application
Application parameters relating to the total diagnostic electronic (VSE) are likewise 
available for each diagnosis object / signal input monitor.
Following application parameters can be adjusted:

VSE type unit used

Input 1 analogue signal for the first value (e.g. speed 1)

Input 2 analogue signal for a second value (e.g. speed 2)

Switching output setting the output, setting outputs OUT1, OUT2 (all VSE)

I/O1…4 
I/O5…8 setting the binary in- or outputs I/O1…8 (VSE100)

Application > VSE-Types
Available versions:
VSE001 / VSE002:  
efector octavis Standard diagnostic electronic for 4 vibration sensors. Signals 
the condition via 2 outputs. Communication Ethernet TCP. Integration into the 
production data acquisition system using the efector octavis OPC server (article 
numbers VOS001...VOS004);
VSE100:  
Diagnostic electronic for 4 vibration sensors. Signals the condition via up to 
10 outputs; electrical switching of up to 8 different triggers (variant switching). 
Communication Ethernet TCP. Integration into the production data acquisition 
system using the efector octavis OPC server (article numbers VOS001...VOS004). 
Alternative analogue input signal (Input 1/ Ínput 2) and analogue output signal 
(OUT1) as voltage signal (0...10V).
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Application > IN1 / IN2
For applications using variable speeds the speed information has to be supplied 
to the diagnostic electronic (VSE). This can be done using an analogue signal or 
pulse input.
Analogue signal:
VSE001 / VSE002: 	0/4...20 mA 
VSE100: 	 0/4...20 mA or 0...10 V
When using a pulse input please ensure that a HTL-level compatible signal source 
is used (e.g. a proximity switch) and that the switching frequency of the used 
signal source is over 0.7 Hz. If using proximity switches please pay heed to the 
proximity switchs‘ switching frequencies.
When using a 0/4..20 mA current loop please enter the lowest and highest 
reference point of the current flow at the appropriate input value (speed).
It is also possible to supply further input values for the second working range or 
counters (signal value input). In addition to supplying an analogue signal or pulse 
input it is also possible to use a pulse width modulation (PMW) or evaluate as a 
counter pulse.
For PWM use the lower and upper reference point of the pulse width for the 
corresponding input value. It is possible to measure pulse widths between 0.1 Hz 
and 20 kHz.
When using the pulse counter please ensure that the pulse trigger is higher than 
5 µs.
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Application > Switching output
The switching outputs of diagnostic electronic (VSE) can be programmed as 
normally closed or normally open. So that wire break can be recognised we 
recommend using normally closed.
OUT1: Binary, analogue
OUT2: Binary.
Analogue output (OUT1):
There are several possibilities to use the analogue output:

●● Object values (a): The measurement values are signalled for the selected dia-
gnosis objects (measurement value vibration acceleration [mg]). If more than 
one diagnosis object is selected to be signalled then the highest value is output 
(overlaying).

●● Object values (v): The measurement values are signalled for the selected 
diagnosis objects (measurement value vibration velocity [mm/s]). If more than 
one diagnosis object is selected to be signalled then the highest value is output 
(overlaying).

●● Object values (s): The measurement values for the selected diagnosis ob-
jects (measurement unit: vibrations path [mm]) are used as output. If several 
diagnosis objects have been defined as output then the highest value is output 
(overlaying).

●● Vibration monitor (a): The values are signalled for the selected vibration 
monitor with vibration acceleration [mg]. If more than one vibration monitor is 
selected to be signalled then the highest value is output (overlaying).

●● Vibration monitor (v): The values are signalled for the selected vibration moni-
tors with vibration velocity [mm/s]. If more than one vibration monitor is se-
lected to be signalled then the highest value is output (overlaying).

●● Upper limit (unit): The input values of the selected upper limit monitor are 
signalled in the unit set for the parameters: If more than one process monitor is 
selected to be signalled then the highest value is output (overlaying).

●● Lower limit (unit): The input values of the selected lower limit monitor are 
signalled in the unit set for the parameters. If more than one process monitor is 
selected to be signalled then the highest value is output (overlaying).

●● Damage levels (absolute): The diagnosis condition of the diagnosis objects are 
signalled as multiples of the individual reference values (Teach values). If more 
than one diagnosis object is selected to be signalled then the highest value is 
output (overlaying). The setting is suitable for diagnosis objects as vibration 
acceleration as well as for diagnosis objects for vibration velocity or vibration 
displacement, as the values have no relation to the physical unit ([mg], [mm/s] 
or [mm]).
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●● Damage levels (relative): The relative proximity to the limit values or their 
exceedance is signalled. If several diagnostic objects/ time domain or process 
monitors are defined then the value which is closest to its limits is signalled 
(overlay). The parameter setting is in [mA] at 0, [mA] for yellow and [mA] for 
red.

A [minimum 4 mA] (or [minimum 2 V]) can be set for wire-break detection, so that 
a minimal current of 4 mA (or a minimal voltage of 2 V) is not undergone.
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Under [Overview...] depending on the select type, the analogue output for 
diagnosis objects / signal input monitors can be activated or deactivated.

Binary output OUT1 and OUT2:
There are 2 possibilities to use the binary outputs:

●● Quick setting "yellow = early warning" and "red = Alarm" for OUT1 and OUT2: 
If "yellow" or "red" have been selected then all the yellow and red thresholds of 
the set diagnosis objects and signal input monitors are automatically signalled 
a summary alarm to the relevant outputs. 

●● Logic for OUT1 and OUT2: 
The function "Logic" sets a logical AND or OR conjunction for the early warning 
and alarm thresholds. 
For example an output can be defined as follows: 
OUT2 = bearingAS(red) AND vibration monitor(yellow)

Optionally, a pulse stretching can be activated for very short switching at the 
output. This pulse stretching maintains a constant output signal for at least 50 ms 
(firmware 0.7.23 or higher).
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Application > In/Outputs
The I/Os 1...8 can be selected as binary outs (OUTPUT) or as digital input 
(INPUT) (for VSE100 only).
Define as binary output (OUTPUT):
The logic function of the binary switching outputs is to be given under [Edit].

AND or OR conjunctions for the early warning and alarm thresholds can be 
configured for all set diagnosis objects and signal input monitors. The outputs can 
also be switched combining a logic OR conjunction for the counter alarm groups.
For example an output can be defined as follows: 
Output I/O1 = Bearing_AS (red) AND signal input monitor "a_max" (yellow).
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Define as digital input (INPUT):
Triggered measurements (variants) can be activated electrically using the digital 
inputs. A so-called level-trigger is used for electrical triggering. This means that if 
the input has a level of 24 V then the selected variant is activated. If the input level 
is shut off then the alternative variant is switched or the variant of the input with the 
lowest value.

If several inputs are switched then the variant of the last ascending output (e.g. 
I/O8) is activated.
If no input is switched then the 0V variant of the last ascending output is activated.



UK

Octavis Software VES003 v3.0

37

Example:

Parameters
Switching 1 Switching 2 Switching 3

24 V 0 V
I/O3 Var1 Var0 24 V 24 V 24 V (Var1)

I/O4 Var2 0 V 0 V 0 V

I/O5 Var3 0 V 24 V (Var3) 0 V

I/O6 Var4 24 V (Var4) 0 V 0 V

If the variants are changed it is possible as an option to carry out a sensor self-test

The I/O 1…8 can be used to activated the counter for operating hours. The 
counter can count the operating hours from 24 V or from 0 V onwards.
The I/O 1…8 can be used to reset the counters to 0.  Use the input mask to define 
which count is to be reset to 0 e.g. when changing from 0 V to 24 V.



Octavis Software VES003 v3.0

38

7.3.2 Parameters > Counter
It is possible to select between an operating hour counter, condition counter or 
totalisator.
An operating hour counter measures the period during which a certain condition is 
complied with.
This condition is defined using a working range on input 1 / input 2. On I/O1…8 the 
condition is defined under the application settings either at 24 V or 0 V.
Condition counters measure the length of time during which a diagnostic condition 
(yellow/red) exists for a pre-defined diagnosis object.
The totalisator cumulates all counter pulses input on input 1 /input 2 without taking 
into account the set counter intervall for the pulse density.
The operating hour counter, condition counter and totalisator on input 1 / input 2 
have to be activated separately. Whereas the operating hour counters on I/O1…8 
are automatically activated when the parameters for the application setting are set 
to [Counter] at 24 V or 0 V.
If the counter reading is above the set alarm limit the group which has been set as 
alarm switches according to predefined setting as an alarm output or I/O.
The counter readings are read out together with the history data and stored in 
the history file and displayed. Using the function [VSE overview] > [Others] it is 
possible to select the values for the counter readings.
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7.3.3 Parameters > Measurement value input
The measurement value input can be used to supply other input values (e.g. Nm, 
kW, K) for direct monitoring (signal input monitor). Possible value sources are 
input 1 / input 2, IP-command (octavis OPC server).
Name/Unit
The free-text description of the set measurement value input which enables the 
information to be located in the parameter set cannot be changed if an analogue 
value source (input 1 / input 2) is used.
The unit of the incoming values can be changed at any time. This has no influence 
over the evaluation and is only used for the display (monitor, history).
Working range
The working range has no influence over the evaluation. It only limits the display in 
the monitoring mode 
lowest value only negative inputs, otherwise 0 
upper value: only positive inputs, otherwise 0.
Please ensure that the limits are suitable so that all the relevant values can be 
displayed in the monitoring mode.
Input using the IP-command (octavis OPC server): 
The initial value determines the value to be used after rebooting unit a new value 
is determined using the first IP-command .
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7.3.4 Parameters > Diagnosis objects
efector octavis sets up an automatic machine diagnosis by defining a machine 
model using so-called diagnosis objects.
Adjustable diagnosis parameters (frequency range)

●● Description: Alphanumeric description of the diagnosis object (e.g. rolling 
element bearing AS)

●● Diagnosis type: Use a diagnosis template (e.g. rolling element bearing)
●● Subobjects: Define the individual frequency bands using frequency factors and 

bandwidths. 
●● Speed: Speed related information for the diagnosis object
●● 2 working range: Further reference value
●● Teach / limit values: Teach value and switching thresholds for "yellow" and "red"
●● History:  Adjusts storage of values in the history memory
●● Damping: Averaging the object value, response delay for the object values
●● Others: Physical unit, evaluation, analysis method, frequency resolution.

The efector octavis diagnostic electronic (VSE) can monitor up to 24 (incl. signal 
input monitor) different diagnosis objects simultaneously. A diagnosis object 
comprises a group of symptomatic damage frequencies (sub objects) which 
are defined in the form of so-called frequency factors. The rotational frequency 
multiplied by the frequency factor results in the actual damage frequency. For 
constant speed applications the damage frequency remains then constant.
Depending on the type of damage the diagnosis object is assigned to a method of 
analysis. For example unbalance is measured using the FFT method and rolling 
element bearing damage is measured using the H-FFT method.

All frequency selective diagnosis objects (not the signal input monitor!) are 
sampled using a multiplexer. The total diagnosis period adjusts itself in addition to 
the number of sensors, also to the individual diagnosis object characteristics, such 
as analysis method (FFT or H-FFT), frequency resolution and physical unit ([mg], 
[mm/s] or [mm]).



UK

Octavis Software VES003 v3.0

41

Example 1:
1 sensor, 2 rolling element bearings (H-FFT; [mg]),  
unbalance (FFT; [mm/s]), frequency resolution 1.52 Hz 
Measurement period for calculating the rolling element: 1/frequency resolution = 0.65 s 
Measurement period for unbalance: 0.65 s
Total measurement period for a complete diagnosis cycle:  
0.65 s + 0.65 s = 1.3 s

Example 2:
2 sensors, each with one rolling element bearing with 1.52 Hz and 0.125 Hz frequency resolution,  
one unbalance with 3.05 Hz frequency resolution 
Measurement period for rolling element bearing sensor 1:	 1/frequency resolution = 0.65 s 
Measurement period for unbalance sensor 1:	 1/frequency resolution = 0.33 s 
Measurement period for rolling element bearing sensor 2: 	 1/frequency resolution = 8 s
Total measurement period for a complete diagnosis cycle:  
0.65 s + 0.33 s + 8 s = 8.98 s

Diagnosis objects > Name / Type
The freely definable description (31 characters) makes it easier to recognise the 
diagnosis object in the parameter set.
The selection of the diagnosis type [Rolling element bearing], [Unbalance], [RMS] 
or [Others] automatically provides setting suggestions for machine diagnosis. This 
automatic configuration greatly simplifies parameter setting. The settings can be 
subsequently fine-tuned.
By selecting [Others] it is possible to monitor parameters for individual machine 
damage if it is characterised by assigned symptomatic frequencies / frequency 
factors.
Diagnosis type [Rolling element bearing]
The parameter setting [Rolling element bearing] determines the rolling element 
bearing condition from the amplitudes of the ball pass frequencies of: 
- Inner race 
- Outer race 
- Rolling elements
The required frequency factors can be found in the rolling element bearing 
database or the damage frequencies can be input directly. The damage condition 
is evaluated based on the Teach values of an intact machine. If the machines 
are identical with the same place of measurement the Teach values are the 
same. These can therefore be entered manually into the parameter set. A Teach 
measurement is not necessary in this case.
Diagnosis type [Unbalance]
The parameters for [Unbalance] determine the machine condition using the 
amplitudes at rotational frequency. The damage condition is evaluated based 
on the Teach values of an intact machine. The standard setting for unbalance 
monitoring is in [mm/s] and RMS. Reference values can also be found for example 
in the general level information in ISO 10816.
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Diagnosis type "A-RMS"
The parameter setting [A-RMS] detects the effective vibration acceleration [mm/s] 
and RMS.
If a new diagnosis object is created the freely definable frequency range is easy 
to set: (frequency factors of the "average frequency" x 100 Hz x (100 ± frequency 
range) / 100).
Diagnosis type [V-RMS]
The parameter setting [V-RMS] detects the effective vibration velocity [mm/s] and 
RMS. For monitoring in accordance with ISO 10816 the frequency range is preset 
to 10...1 000 Hz.
If a new diagnosis object is created the freely definable frequency range is easy 
to set: (frequency factors of the [average frequency] x 100 Hz x (100 ± frequency 
range) / 100).
Diagnosis type "D-RMS"
The parameter setting "D-RMS" detects the effective vibration displacement [mm] 
and RMS. 
If a new diagnosis object is created the freely definable frequency range is easy 
to set: (frequency factors of the "average frequency" x 100 Hz x (100 ± frequency 
range) / 100).
Diagnosis type [Others]
The parameters can be set for any machine damage under the damage type 
[Others] by entering specific damage frequencies (frequency factors) per diagnosis 
object (also see: Diagnosis examples). 
The damage condition is evaluated based on the Teach values of an intact 
machine.
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Diagnosis objects > Subobjects
Enter the damage frequencies (subobjects) which are to be assigned to a 
particular type of machine damage (diagnosis object). The description of the 
damage frequency is made using a so-called frequency factor analysis. Whereby 
the sought frequency from the frequency factor is multiplied by the current 
rotational frequency: 
damage frequency = frequency factor x rotational frequency
Example:  
Frequency factor = 6.23,  
rotational frequency = 50 Hz (3 000 rpm)  
→ damage frequency = 311.5 Hz 

A total of maximum 84 individual subobjects (incl. 1 sub object per signal input 
monitor) can be defined, which can be assigned to a maximum of 24 (incl. signal 
input monitor) diagnosis objects. The characteristic data for the diagnosis object is 
calculated using the summation of the individual amplitudes at the given frequency 
(object value).
For the diagnosis type [Rolling element bearing] refer to the rolling element 
database for the fundamental frequencies.
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Each subobject has an individual search range (frequency window), in which the 
damage amplitudes are determined. The frequency window is given as a relative 
window below and above the calculated damage frequency. If the diagnosis object 
[Rolling element bearing] has been selected from the rolling element bearing 
database then the required frequency window is calculated automatically.
Example:  
Frequency window = 5 %; damage frequency = 192.23; Resolution 1.25 Hz 
192.25 Hz corresponds to spectral lines 153.8 → 153 
Search range = spectral lines 145...160 corresponds to 181.25...200.00 Hz 
(→ image)
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Diagnosis objects > Speed
The rotational frequency used to calculate the damage frequency can be defined 
as constant speed or supplied to signal inputs IN1 / IN2 during operation or by 
using a special Internet protocol.
Please ensure that when inputting the constant speed the nominal speed is given 
under nominal load.
Transferring the speed information using IP-command: 
After reboot the set initialising speed remains valid. An IP-command can be used 
to redefine the speed for the calculation.
Transferring the speed information using analogue inputs: 
The gear transmission describes the relation between the speed input from the 
machine to the speed of the  of the monitored diagnosis object.
If the speed values differ more than 5 % immediately before or after the 
measurement (measure period see frequency resolution) and the deviation 
monitoring is active, then the measurement results are ignored, a new object value 
is not determined and therefore a new damage level cannot be calculated.
The condition of the diagnosis object is only monitored and signalled within the 
speed-working range. So long this speed input is outside the working range no 
monitoring takes place.

3

5 6

4

2

1

Legend:
1 = speed
2 = lower operating speed
3 = upper operating speed
4 = Teach-In
5 = no monitoring
6 = monitoring
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Diagnosis objects > 2nd Working range
The working range described under "Speed" can be extended by an additional 
input value. This value can be transferred during machine operation using the 
signal inputs input 1 / input 2 or by using an Internet protocol (octavis OPC server).

Using constant speed monitoring can be determined independent of further input 
values
When using the signal weighting it is possible to determine if monitoring should 
take place outside limits of the 2nd working range. In this case the limits of the 
2nd working range are used to set the range of the signal weighting to be created. 
Values outside the working range are weighted according the closest signal 
weighting point.

Transferring the speed information using IP-command: 
After reboot the set initial value remains valid. An IP-command can be used to 
redefine the speed for the calculation.
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Diagnosis objects > Teach-In / Limit values
The auto-teach function is used to "Teach" the diagnostic electronic (VSE).
If the required Teach values have been calculated or if they are already available 
for an identical reference machine, they can be used for the parameter set and/or 
written on to the diagnostic electronic instead of using the Teach function. When 
creating a diagnosis object a value based on the experience of several factors is 
automatically  input. For variable speed monitoring it is also necessary to give the 
reference speed for the teach value. The same is valid for the 2nd working range.
If the value "0" is entered the teach values already set in the diagnostic electronic 
remain unchanged. 
efector octavis uses own limit values for all set diagnosis objects for early warning 
(yellow) and main alarm (red). The limit values always refer to the set Teach value 
and thus describe a signal multiplication. The limit values for diagnosis types 
[Rolling element bearing] and [Unbalance] are pre-set.
Diagnosis objects > History
Selective activating / deactivating modifying the integrated history memory for the 
diagnostic unit.
This is carried out for all diagnostic objects and signal input monitors clearly set 
out in the history settings for the whole parameter set.



Octavis Software VES003 v3.0

48

Diagnosis objects > Damping
Averages
The diagnosis object values are sliding averages using an "exponentially weighted 
moving average" (EWMA). The new diagnosis object value is calculated using the 
previous diagnosis object value as per following example: 
Example: 
Set averages: 1/4,  
previous diagnosis object value = 17.3 mg,  
new measurement = 14.7 mg 
→ new diagnosis object value: (17.3 mg x 3/4) + (14.7 mg x 1/4) = 16.65 mg

Initialisation
The process variables for the diagnostic electronic are re-initialised when 
rebooted, variants have been changed or after parameters or settings have been 
transferred or after monitoring (for spectral view only). It is then possible to decide 
at start-up of the measurements whether the diagnosis object values should be 
continued to be averaged using the last values or if it is necessary to start at "0" 
again.
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Re-entering the working range
It is possible to decide after re-entering the working range diagnosis object value 
should be continued to be averaged using the last values or if it is necessary to 
start at 0 again.
Response delay
To avoid false alarms the response delay has the default setting 5. This means 
that an increase in the diagnosis value is only shown after 5 increases in 
succession have taken place. The effectiveness of the diagnosis information is 
therefore ensured. 
You can set the response delay between 1 (no delay) and 100. 
The response delay reacts to deviations around the given limit value and also to 
frequent deviations above or below this value.
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Diagnosis objects > Others
Evaluation
The narrowband characteristics, the Peak-max and the RMS value (average 
value) can be detected in the search range. Peak analysis is recommended 
for discrete damage frequencies (e.g. the ball pass frequencies for rolling 
element damage or unbalance). RMS analysis is recommended for statistical 
characteristics (e.g. cavitation).

Measurement values
Either the acceleration value [mg], vibration velocity [mm/s] or the vibration 
displacement [mm] is used for calculation purposes. The physical unit should also 
be included in the Teach value. For measurement values in RMS and evaluation 
in [mm/s] it is also possible to define an ISO conform level for effective vibration 
velocity in a user defined band.
The centre frequency 505 Hz and a relative bandwidth of 98 % result in the 
effective vibration velocity in a band of 10...1 000 Hz (according to ISO 10816).
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Analysis method / Filter
The purpose of the signal analysis is to generate informative characteristics from 
the raw acceleration data. efector octavis uses fast frequency analysis methods 
(Fast Fourier Transformation = FFT). The analysis method differentiates between 
calculating the linear spectrum from the raw acceleration data (FFT) and the 
envelope of the acceleration data (H-FFT). The selected method of analysis can 
be assigned individually to each diagnosis object. For example unbalance and 
rolling element bearing damage can be monitored in one sensor.

●● Applications for FFT: 
Evaluating harmonic signals e.g. unbalance, cavitation, resonance, alignment 
errors.

●● Applications for H-FFT: 
Evaluating high frequency peak-shaped signals e.g. rolling element bearings. 

When using H-FFT it is possible to select different preset signal filters.
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Frequency resolution
The frequency resolution is indirectly proportional to the measurement time. An 
high frequency resolution requires a long measuring time. 
For reliable monitoring at least 1.5 shaft revolutions should occur within one 
measure time.
Example:
Frequency resolution = 1.52 Hz 
→ Measurement time = 0.65 s
Minimum shaft revolution = 1.52 Hz x 1.5 = 2.25 Hz 
2.25 Hz x 60 s/min = 135 rpm
Shortest programmable measurement time: 0.040 s = 24.4 Hz  
→ shaft revolution minimum = 2 196 rpm
Longest programmable measurement time: 2.6 s = 0.38 Hz 
→ shaft revolution minimum = 34 rpm
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Diagnosis objects > Signal weighting
It is possible to correct the measuring value independently of the variable speed 
and/or the input value of the 2nd working range. The values displayed indicate 
how the variables of a constant damage change in the working range. During 
evaluation and calculation the VSE takes this change into account.

The signal weighting comprised 128 values between 0 and 65 535. The Teach 
value as well as the measured value are weighted using the signal weighting table 
(see example) – the Teach value using the Teach-In speed, the measured value 
using the measured speed.
Example calculation:
Teach t at 1500 rpm (35790 in the signal weighting). Object value a at 2450 rpm (50636 in the signal 
weighting.
The VSE determines the diagnosis value: (a / 50636) / (t / 35790) = diagnostic value. 
(a / 50636) x (35790 / t ) = diagnostic value.
(35790 / 50636) x a / t = diagnostic value.
(0.707 x a) / t = diagnostic value.

To simplify calculating a signal weighting it is possible to linearly divide the value of 
the Y-axis . However, the Teach-speed value must be 1.
It is possible to use ready defined curves or to produce or load own curves.
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7.3.5 Parameters > Signal input monitor
The purpose of the signal input monitor is to offer additional monitoring of 
measurement signals or characteristics in the time domain in addition to the 
frequency selective (i.e. narrow band) measurement of diagnosis objects. This 
so-called broad band measurement makes it possible to give general information 
about the total system by evaluating the raw acceleration signal of the sensors for 
maximum acceleration (RMS in [mg]), average speed (RMS in [mm/s]) or input 
process values. In contrast to the diagnosis objects this monitoring is in absolute 
values.
The level values are determined without multiplexing, quasi simultaneously and is 
permanently available to all connected sensors without interruption. This means 
that time-critical monitoring such as crash recognition (0_pk_max) or time-critical 
shutdown functions can be realised using the vibration monitor. Basically up to four 
peak monitors (0_pk_max) and four RMS ([mm/s] or [mg]) can be simultaneously 
monitored. If using the RMS value the default setting for the filter range is in 
accordance with the ISO standards (2...1 000 Hz). The filter range can be freely 
defined so that individual levels can be calculated.
Adjustable parameters

●● Switching points: Swithing thresholds "yellow" and "red" as absolute 
measurement values.

●● Damping: averages, initialisation, response delay,
●● Details: Measurement time, filtered / unfiltered measurement.
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The process monitor is used to directly monitor the speeds of input 1 /input 2 and 
the input parameters of a measurement value input
Adjustable parameters

●● Switching points: Switching thresholds "yellow" and "red" as absolute 
measurement values.

●● Damping: averages, initialisation, response delay,
Signal input monitor > Monitoring
The monitoring mode determine whether the vibration monitor should monitor.

●● RMS of the vibration acceleration in [mg]
●● Maximum acceleration value in [mg], 0-peak
●● RMS of the vibration velocity in accordance to ISO 10816 in [mm/s]

Signal input monitor > Switchpoints
efector octavis uses own limit values to monitor the vibration level within the time 
domain and the measurement value inputs. Contrary to the diagnosis objects the 
acceleration values are absolute for acceleration (unit: [mg]) and velocity (unit: 
[mm/s]), or the relevant set unit for the measurement value input.
Two trigger levels can be defined (yellow and red) which can also be used to 
switch the outputs.
Units: 
1 mg = 0.001 g 
1 g = 9.81 m/s² (gravitational acceleration)
Signal input monitor > History
Selective activating /deactivating and modifying of the integrated signal input 
monitor history memory.
This is carried out for all diagnostic objects and signal input monitors clearly set 
out in the history settings for the whole parameter set 
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Signal input monitor > Damping
Averages
The signal input monitor values are sliding averages using an "exponentially 
weighted moving Average" (EWMA). The new signal input monitor is calculated 
using the previous signal input monitor value as per following example:
Example: 
Set averages: 1/4,  
previous signal input monitor value = 1 318 mg,  
new signal input measurement = 1 634 mg 
→ new signal input value: (1 318 mg x 3/4) + (1 634 mg x 1/4) = 1 397 mg

Initialisation
The diagnostic electronic process variables are reinitialised when rebooted, 
variants are changed, after transfer of parameters or settings and after monitoring 
("spectral view" only). Here it is possible to differentiate whether at start up of the 
measurements the average of the diagnostic object value is continued with the last 
determined values. or if the evaluation diagnostic object should start from "0".
Response delay
To avoid false alarms the response delay has the default setting 5. This means 
that an increase in the diagnosis value is only shown after 5 increases in 
succession have taken place. The effectiveness of the diagnosis information is 
therefore ensured.
You can set the response delay between 1 (no delay) and 100.
The response delay reacts to deviations around the given limit value and also to 
frequent deviations above or below this value.
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Signal input monitor > Details
Measurement periods
Longer periods of measurement ensure more stable measurement results. In 
some applications, however, a shorter reaction time is required. Accelerometers 
according to ISO 10816 require a minimum measuring time of 333 ms in order to 
completely detect a vibration of 3 Hz.
Shorter measuring periods have the effect of additional high pass filters. For 
example, a measurment time of 80 ms can reduce frequencies up to 12.5 Hz.
Filtering
The filter can either be freely adjusted or the peak can be unfiltered over the total 
frequency range. It can be useful to use an unfiltered measurement for e.g. the 
monitoring of very slow rotating machinery (< ≈100 rpm).
Signal input monitor > Input value
During operation the input value is taken from the signal inputs input 1 / input 2 or 
transferred using IP-protocol (octavis OPC-Server).
The condition of the signal input monitor is only monitored and signalled within the 
working range. No monitoring takes place during the periodthe input values are 
outside the working range.
Using the signal weighting function it is possible to adjust settings to monitor 
outside the working range limits. In this case the limits for the working range 
represent the range for which the signal weighting is to be created. The values 
outside the working range  are weighted according to the nearest signal weighting 
point.
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Signal input monitor > Signal weighting
Depending on the input value it is possible to correct the measurement values. 
The plotted values show how the characteristic values of a constant damage 
change within the working range. The VSE takes these changes into consideration 
during evaluation and calculation.

The signal weighting comprises 128 values between 0 and 65535. The reference 
value and the measured value are weighted according to the signal weighting 
table (see example) - the reference value according to the given reference and the 
measured value according to the measured input value.
Example calculation: 
Reference r ati 72 Nm (35790  signal weighting),  
Signal input monitor value: a at 117 Nm (50636 signal weighting) 
VSE determines the measurement value: (a / 50636) / (r / 35790)  
	 = weighted measurement value signal input monitor 
(a / 50636) x (35790 / t) = weighted measurement value signal input monitor 
(35790 / 50636) x a / t = weighted measurement value signal input monitor 
(0,707 x a) / t = weighted measurement value signal input monitor

To facilitat the signal weighting it is possible to linearly divide the values of the Y-
axis . However, it only possible the set the reference value at 1.
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7.3.6 Parameters > History
Activating and deactivating the integrated history memory.

The memory size amounts to 30 000 values including time stamp and speed 
details. These are segmented to the activated diagnosis objects /signal input 
monitors. The integrated real-time clock is battery-backed; the memory is a ring 
memory.
The storage intervals are freely definable. The maximum value of the relevant 
diagnosis object / signal input monitor is stored within one storage interval. To 
save memory the speed details e.g. diagnostic objects with constant speed can be 
deleted from the history memory (n).
From firmware 0.5.17 onwards it is possible to include or ignore storing the 2nd 
working range or reference value (2).
It is possible to adjust settings so that the history records each change to variants 
(v). However, each history record made due to a change to the variants shortens 
the time memory available.
From firmware 0.6.8 it is also possible to store the average value of the values 
measured during the interval.
From firmware 0.7.11 it is possible to adjust settings so that a history recording is 
taken each time the limit value for "red" is exceeded (d).
If the measurement value of an object moves quickly between yellow and red 
alarm (< 250 ms) and each red alarm is documented, these events can shorten 
the sensitivity of the period the values can be stored. It is possible to interrupt 
storage of new values for approx 1 sec (min. firmware 0.7.23).
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7.3.7 Parameters > Variants
The variant is always the decisive setting. In each of the 32 variants diagosis 
objects / signal input monitors are activated or deactivated. As a default setting all 
diagnosis objects /signal input monitors are active in all variants.

all VSE:
Up to 32 variants can be defined. Each variant can be activated or deactivated 
using the setting dialogue and the efector octavis OPC Server software.
VSE100 only:
Electrically it is possible to activate or deactivate up to 9 variants using the level-
trigger (8 digital inpuots I/O 1…8). An optional setting is available to carry out a self 
test if a change is made to a variant.
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7.3.8 Parameters > Project
The purpose of the header data is to describe the application. The free text inputs 
are stored in the parameter file and in the diagnostic electronic (VSE).

–– Company
–– City
–– Address
–– Machine location
–– Machine spec.

The purpose of the project description is to archive project notes. In the diagnostic 
electronic (VSE) the first 104 characters are stored, in the parameter file all data is 
stored.
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7.3.9 Parameters > Sort ID
Changes to the parameter sets can lead to a new configuration of the diagnosis 
objects with reference to their object-ID. This is valid in particular for inputs 
concerning the RPM-object-ID. Therefore when using the OPC server (article 
numbers VOS001...VOS004) you should, prior to transfering the parameters to the 
VSE, align the ID sorts with the configuration of the OPC client in use.
Menu [Parameter] > [Sort ID...] or 
symbol 

Use the mouse to move the diagnosis object fields (e.g. ) to the required 
ID positions (e.g. "Object8”). If an ID position is already occupied then the 
diagnosis object fields are swopped.
The same procedure is valid for the input fields (e.g. ) in the right column.
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7.4 Data / Files > Measuring data
The measuring data window is used to visualise the recorded data in chronological 
order with . Use the symbol [Pause]  to "freeze" the recording. The detail 
screen symbols  enable to switch to the previous or subsequent data set of 
the recording during standstill.
It is possible to switch to the views of individual sensors for recordings of 
subobjects, objects and diagnosis values. The recordings contain the measuring 
values for all sensors. (For technical reasons this is not possible for the spectral 
display).
Recording of object and diagnostic values can also be shown as line diagrammes 
similar to the history function .

7.5 Data / Files > History
Displays the history information which is read out and/or stored as a file.
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The screen can be extended individually to display several values. If within the 
given time the parameters (including Teach values) of the shown diagnosis object 
have been changed, the values which have been recorded before the change has 
taken place are shown in a slightly darker coloured line.
When the data is imported the time stamp is extrapolated to the relevant local 
time. The display can be switched to show any time zone.
Note: If the clocks have changed during the reporting period, the data stored 
before the change will also be shown in the currently valid time.
Tip: GMT/UTC has no time difference (summer/normal time).
The relevant measurement time points of the applied speed or – if set – the input 
values of the 2nd working range can also be displayed (dotted line, scaling axis 
right).
It is possible to zoom into the diagram by drawing a rectangle (keep left mouse 
button pressed and drag from top left corner to bottom right corner). To zoom out 
again repeat in the opposite direction.
Using the right mouse button it is possible to show the limit value of a selected 
diagnosis object/signal input monitor, the cursor and determine the scaling up and 
down of the left Y-axis.
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The arrow keys ([arrow right], [arrow left]) can be used to move the cursor.  
Input focus on the left cursor with [Pos1] or [Strg]+[arrow left], 
input focus on the right cursor with [End] or [Strg]+[arrow right].
The symbol [counter]  can be used to open a window showing the counter 
readings.
The symbol [Diagram to clipboard]  can be used to copy an inverted copy of the 
diagram to the clipboard.
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7.6 Settings
The diagnostic electronic settings can as for parameters also be created "offline" 
and forwarded in file format.
Following settings can be predefined:

–– Password protection
–– Sensors
–– Sensor self-test
–– Network
–– Variants.

Settings which have not been specified are not affected when transferred to the 
diagnostic electronic (VSE). The previous setting remains.
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8 Tools
8.1 Tools > Search VSE
Menu [Extras] > [Search VSE…]

The above lists shows only units with firmware version 0.6.8 onwards which are 
located in this/these subnet(s).
Double click one of the listed units to annex it to the VSE overview tree and to 
establish connection.
Note: The search can be repeated at will.
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8.2 Tools > Rolling element bearing database
The rolling element database contains the most common rolling element bearings 
from different manufacturers. These can be defined by inputting the bearing short 
description.

If the required rolling element bearing cannot 
be found in the database, you can enter the 
bearing description, the frequency factors and 
the search radius manually. (→ image).
Please note that some manufacturers' specifi-
cations only give half the frequency factors for 
the rolling elements.

The bearing calculator can be used to calcu-
late the order numbers if the bearing geometry 
is known.
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8.2.1 Short description (=DIN)
Each standard rolling element bearing has a short description according to 
DIN 623 with which it can be clearly assigned to a particular group of bearings. 
The geometric data can also be identified from the description. The ball pass 
frequencies are also described.
Suffixes and prefixes normally do not have any influence on the balls pass 
frequencies. Only the suffix "E" usually indicates a reduced number of rolling 
elements and is therefore relevant for the ball pass frequency. Differences 
between the manufacturers are on the whole marginal. Bearing descriptions with 
more than five digits are special constructions. In this case you should consult the 
manufacturers‘ database.

The last two digits define the inner diameter of the bearing multiplied by 5:
Example: 
Bearing 6(0)212: 
Inner diameter = 12 x 5 = 60 mm

Important: The data pertaining to the different bearings is a service offerend 
free of charge. We cannot guarantee the correctness of the data. If in doubt or if 
the required rolling element bearing is not available please contact the bearing 
manufacturer.
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8.3 Tools > Object-ID

Shows the object-ID used for the octavis 
OPC server. 
Press [Strg] key and using the mouse 
click on the relevant diagnosis object 
listed in the diagnosis tree.

8.4 Tools > Start parameters
Following start parameters are available:

Start parameter Properties
IEPE For units with board-version 3 or lower it is also possible to set 

[Sensor 1] as IEPE-sensor

FRAME-left_top_right_bottom The screen range available for parameter setting software VES003

aaa.bbb.ccc.ddd A connection to diagnostic electronics VSE is being created with 
given IP address (aaa.bbb.ccc.ddd)

aaa.bbb.ccc.ddd/eeee A connection to diagnostic electronics VSE is being created with 
given IP address (dito, eeee= port number)

IPPORT It is possible to create connections to the diagnostic electronics 
VSE with the same IP address provided different port numbers are 
used.*)

NOCONNECT At program start-up it is not possible to create an automatic connec-
tion to the diagnostic electronics VSE.*)

*) Can also be found under [program settings]

Use:
Start the software using the command line and add the required start parameters. 
These should be separated by a blank. The order is not important.
Or create a link with octavis VES003.exe. Click on the link using the right mouse 
button to open the property information.  
Input box [Target]: input a blank after the file name and then the start parameter.
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The example given below opens the software at position 100 pixel to the right, 200 
pixel down, 1 024 (1 124 - 100) pixel wide and 768 (968 - 200) pixel up.
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8.5 Tools > Evaluating the rolling element bearing
The following table can be used to obtain a basic qualitative evaluation of the 
rolling element bearing condition:

In addition to the above the development of the characteristics should be followed 
over a few weeks (e.g. by reading out the history memory) and then make any 
necessary adjustments to the limit values.
The absolute measurement values of the bearing condition can be estimated as 
follows:
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For speeds below 120 rpm we recommend also using the vibration monitor 
function for peak_max.

If the levels are higher than the recommended alarm limits right from the 
beginning, then following steps should be taken:

●● increase the damping to lower the evaluation of sudden influences
●● reduce the search window for the damage frequencies  
→ narrower frequency bands are less subject to interference

●● as last step it is possible to take diagnosis measurement in the working ranges 
or using external trigger signals during interference free operation.

Important: Diagnosis measurements (bearing condition, gear diagnosis...) have to 
be taken under reproducible conditions. Constant detection is not so important as 
reliable diagnosis information!
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8.6 Tools > EMWA averaging
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8.7 Tools > Time domain evaluation
According to ISO 10816 it is possible to make a basic quantitative time domain 
evaluation.
Individual diagnosis objects (e.g. unbalance) measured in [mm/s] and RMS can 
also be orientated on the values.
g-Monitor 
mm/s RMS
(10...1,000 
Hz)

Large electric  
machines

Middle sized electric 
machines

Pumps with impellers 
with several blades 
and seperate drive

Pumps with impellers 
with several blades 
and integrated drive

P = 300 kW...50 MW P = 15...300 kW P > 15 kW P > 15 kW
Machines with shaft 

height > 315 mm
Machines with shaft 
height 160...315 mm

fixed flexible fixed flexible fixed flexible fixed flexible
> 11.00 D D D D D D D D
7.10...11.00 D C D D D C D D
4.50...7.10 C B D C C B D C
3.50...4.50 B B C B B B C B
2.80...3.50 B A C B B A C B
2.30...2.80 B A B B B A B B
1.40...2.30 A A B A A A B A
0.00...1.40 A A A A A A A A

Legend:
A = New machine condition 
B = Unlimited long-term operation allowable 
C = Short-term operation allowable 
D = Vibration causes damage

For applications involving fast rotating machines (Machine tool spindles) it is 
necessary to differentiate between unbalance and time domain monitoring.
Permissible residual unbalances are aligned according to the prescribed 
unbalance classes (A...D) and are considered acceptable up to 2 mm/s. 
Sensible thresholds for time domain monitoring (10...1 000 Hz) in metal cutting 
processes are approx 10 mm/s for early warning and 15 mm/s for alarm.



Octavis Software VES003 v3.0

76

8.8 Tools > Extended diagnosis
Diagnosis examples:
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9 Lexicon
9.1 Net Command
The Net command is a standard TCP/IP protocol. The data to be transferred 
comprises three parts:

●● News-ID
●● IP command-ID
●● Speed information.

The News-ID is fixed at "38".
The IP command-ID is derived from the diagnosis object in question (→ following 
screenshot).

The speed information is given as a floating point value in the value range of 4 bit 
floating point number according to IEEE-standards.
The values to be transferred are composed as follows:
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9.2 CSV (separator) (*.csv)

9.2.1 CSV > Diagnostic value (LED)
The CSV values are separated using a semicolon (;), as in this example opened 
with "OpenOffice Calc".
The decimal separator used is the character used in line 1, column N.
Note: The contained data can be shown differently depending on the program 
used.

The most important header data in this case can be found in lines 7...15 (violet, 
diagnosis objects) and 42…46 (yellow, speed values).
Violet:

Column Content
A identification number (ID) of the diagnosis objects

P information pertaining to the diagnosis objects in clear text 
e.g. object name, output unit and limit values

Yellow:

Column Content
A identifikation number (ID) of the speed values

E the unit

F a description of the value inputs
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The data being recorded are below the title line (in this case line 47):

Column Content
A time stamp which is exact to the second

B ID of the relevant diagnosis objects

C measured value in the unit, which is given in the header for the diagnosis object

D speed assigned to the diagnosis in [rpm]

E more measurement details (as a bit mask):

F status of the LED display (as a bit mask):

Bit 0: Sens1 Yellow 
Bit 1: Sens2 Yellow 
Bit 2: Sens3 Yellow 
Bit 3: Sens4 Yellow

Bit 4: Sens1 Red 
Bit 5: Sens2 Red 
Bit 6: Sens3 Red 
Bit 7: Sens4 Red

G diagnosis object ID, the value of which is output on OUT1

H output current on OUT1 in [mA]

I switching output status OUT1 and OUT2 (as a bit mask):

Bit 0: OUT1 switched Bit 1: OUT2 switched

J switching output status I/O 1...I/O 8 (as a bit mask):

Bit 0: I/O 1 switched 
Bit 1: I/O 2 switched 
Bit 2: I/O 3 switched 
Bit 3: I/O 4 switched

Bit 4: I/O 5 switched 
Bit 5: I/O 6 switched 
Bit 6: I/O 7 switched 
Bit 7: I/O 8 switched

K, L input values in [rpm] for input 1/2 or in other units

M...AJ valid speed values in [rpm] or in other units, which are given under speed in the header: 
M "aux3" = ID 0 
N "aux4" = ID 1 
O "aux5" = ID 2...
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9.2.2 CSV > Objects (OBJ)
The CSV values are separated using a semicolon (;), as in this example opened 
with "OpenOffice Calc".
The decimal separator used is the character used in line 1, column N.
NOTE: The contained data can be shown differently depending on the program 
used.

The most important header data in this case are given in lines 7...15 (violet, 
diagnosis objects) and 30…34 (yellow, speed values).
Violet:

Column Content
A identification number (ID) of the diagnosis objects

P information pertaining to the diagnosis objects in clear text 
e.g. object name, output unit and limit values

Yellow:

Column Content
A identifikation number (ID) of the speed values

E the unit

F a description of the value inputs
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The data being recorded are below the title line (in this case line 35):

Column Content
A time stamp which is exact to the second

B ID of the relevant diagnosis objects

C measured value in the unit, which is given in the header for the diagnosis object

D speed assigned to the diagnosis object in [rpm]

E more measurement details (as a bit mask):

F status of the LED display (as a bit mask):

Bit 0: Sens1 Yellow 
Bit 1: Sens2 Yellow 
Bit 2: Sens3 Yellow 
Bit 3: Sens4 Yellow

Bit 4: Sens1 Red 
Bit 5: Sens2 Red 
Bit 6: Sens3 Red 
Bit 7: Sens4 Red

G diagnosis object ID, the value of which is output on OUT1

H output current on OUT1 in [mA]

I switching output status OUT1 and OUT2 (as a bit mask):

Bit 0: OUT1 switched Bit 1: OUT2 switched

J switching output status I/O 1...I/O 8 (as a bit mask):

Bit 0: I/O 1 switched 
Bit 1: I/O 2 switched 
Bit 2: I/O 3 switched 
Bit 3: I/O 4 switched

Bit 4: I/O 5 switched 
Bit 5: I/O 6 switched 
Bit 6: I/O 7 switched 
Bit 7: I/O 8 switched

K, L input values in [rpm] for input 1/2 or in other units

M...AJ valid speed values in [rpm] or in other units, which are given under speed in the header: 
M "aux3" = ID 0 
N "aux4" = ID 1 
O "aux5" = ID 2...
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9.2.3 CSV > Subobjects (SUB)
The CSV values are separated using a semicolon (;), as in this example opened 
with "OpenOffice Calc".
The decimal separator used is the character used in line 1, column N.
NOTE: The contained data can be shown differently depending on the program 
used.

The most important header data in this case are given in lines 16…26 (violet, 
subobjects) and 42…46 (yellow, speed values).
Violet:

Column Content
A Identification number (ID) of the subbjects

F information pertaining to the subobjects in clear text 
e.g subobject name, output unit and affiliation

Yellow:

Column Content
A identifikation number (ID) of the speed values

E the unit

F a description of the value inputs
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The data being recorded are below the title line (in this case line 35):

Column Content
A time stamp which is exact to the second

B ID of the relevant subobjects

C measured value in the unit, which is given in the header for the subobject

D speed assigned to the subobject in [rpm]

E position in [Hz] peak pertaining to the subject within the spectrum

F more measurement details (as a bit mask):

G status of the LED display (as a bit mask):

Bit 0: Sens1 Yellow 
Bit 1: Sens2 Yellow 
Bit 2: Sens3 Yellow 
Bit 3: Sens4 Yellow

Bit 4: Sens1 Red 
Bit 5: Sens2 Red 
Bit 6: Sens3 Red 
Bit 7: Sens4 Red

H diagnosis object ID, the value of which is output on OUT1

I output current on OUT1 in [mA]

J switching output status OUT1 and OUT2 (as a bit mask):

Bit 0: OUT1 switched Bit 1: OUT2 switched

K switching output status I/O 1...I/O 8 (as a bit mask):

Bit 0: I/O 1 switched 
Bit 1: I/O 2 switched 
Bit 2: I/O 3 switched 
Bit 3: I/O 4 switched

Bit 4: I/O 5 switched 
Bit 5: I/O 6 switched 
Bit 6: I/O 7 switched 
Bit 7: I/O 8 switched

L, M input values in [rpm] for input 1/2 or in other units

N...AK valid speed values in [rpm] or in other units, which are given under speed in the header: 
N "aux3" = ID 0 
O "aux4" = ID 1 
P "aux5" = ID 2...
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9.2.4 CSV > Spectral Display (SPEC)
The CSV values are separated using a semicolon (;), as in this example opened 
with "OpenOffice Calc".
The decimal separator used is the character used in line 1, column N.
NOTE: The contained data can be shown differently depending on the program 
used.

The most important header data in this case are given in lines 28 (violet, settings) 
and 43…47 (yellow, speed values).
Violet:

Column Content
I information such as analysis method, frequency band, resolution, measurement value

Yellow:

Column Content
A identifikation number (ID) of the speed values

E the unit

F a description of the value inputs
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The data being recorded are below the title line (in this case line 48):

Column Content
A time stamp which is exact to the second

B...Y valid speed values in [rpm] or in other units, which are given under speed in the header: 
B "Speed[0]" = ID 0 
C "Speed[1]" = ID 1 
D "Speed[2]" = ID 2...

Column Content
Z status of the LED display (as a bit mask):

Bit 0: Sens1 Yellow 
Bit 1: Sens2 Yellow 
Bit 2: Sens3 Yellow 
Bit 3: Sens4 Yellow

Bit 4: Sens1 Red 
Bit 5: Sens2 Red 
Bit 6: Sens3 Red 
Bit 7: Sens4 Red

AA diagnosis object ID, the value of which is output on OUT1

AB output current on OUT1 in [mA]

AC switching output status OUT1 and OUT2 (as a bit mask):

Bit 0: OUT1 switched Bit 1: OUT2 switched

AD switching output status I/O 1...I/O 8 (as a bit mask):

Bit 0: I/O 1 switched 
Bit 1: I/O 2 switched 
Bit 2: I/O 3 switched 
Bit 3: I/O 4 switched

Bit 4: I/O 5 switched 
Bit 5: I/O 6 switched 
Bit 6: I/O 7 switched 
Bit 7: I/O 8 switched

AE, AF input values in [rpm] for input 1/2 or in other units

AG...BD valid speed values in [rpm] or in other units, which are given under speed in the header: 
AG "aux3" = ID 0 
AH "aux4" = ID 1 
AI "aux5" = ID 2...
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Column Content
BE...end 
of line

the individually measured amplitudes on the mesh points startings with the first position of the 
frequency band spaced according to the resolution (frequeny band and resolution see header 
data) 
For example: 
Frequency band "0…1297 Hz" and resolution "1.52588" Hz": 
0Hz, 1.52588 Hz, 3.05176 Hz, 4.57764 Hz etc.
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9.2.5 CSV > History (H)
The CSV values are separated using a semicolon (;), as in this example opened 
with "OpenOffice Calc".
The decimal separator used is the character used in line 1, column H.
NOTE: The contained data can be shown differently depending on the program 
used.

The most important header data in this case are given in lines 7, 9, 11, ..., 23 
(violet, diagnosis objects).
Violet:

Column Content
A identification number (ID) of the diagnosis objects

B information pertaining to the diagnosis objects in clear text 
e.g. object name, output unit and limit values
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The history data being recorded are below the title line (in this case line 31):

Column Content
B time stamp which is exact to the second 

Important: The time stamp is given in GMT-time and has to be converted to local time.

D ID of the relevant diagnosis objects

E the highest measured value in the unit given under diagnosis object in the header

F speed assigned to the diagnosis object in [rpm] 
("-INF" if the speed recording has not been selected)

H value of the 2nd working range assigned to the diagnosis object

I the average value measure in the unit given under diagnosis object in the header
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